Active Worlds Basics

This document provides an overview of the following topics:

1. Installing the client

2. Overview of the client interface

3. Navigating and communicating in Active Worlds

4. Building in Active Worlds

5. Assigning behaviors to objects in Active Worlds

6. Creating your own object models and media in Active Worlds

More detailed information in these topics and others are available on www.activeworlds.com/help

Installing the client:

Active Worlds is a client/server application. This means that the server software is running all the time on a server computer and the client software runs on your local computer whenever you launch the application. The server software maintains information about the objects in the world and sends this information to all connected clients. The server software also manages the interaction between the people in the world by having each client communicate directly with the server, and the server distributes the relevant information to each connected client. You can run the client software from your own computer, or from the computers in the lab. If you want to run the client software from your own computer, please send email to marym@mit.edu and request the information about the client download location. 

The system requirements for the installing the client on your own computer are:

Pentium II CPU 300mhz or equivalent
128MB Memory
Microsoft Windows 98, Me, 2000, or XP
500MB free disk space
DirectX 8.1 or later
Windows Media Player 6.4 or later
3D accelerated video card with at least 8MB

Some of you might experience firewall and server problems, please refer to relevant sessions in AW Help: “http://www.activeworlds.com/help/”. 

After installing the browser, start the application, for those of you who have no citizenship in this universe, click “Tourist” button from the “Enter Virtual World as…” window, fill in the required information and click “OK”. After you login as a tourist, as an enrolled student, you are allowed to immigrate as a citizen to have full access to the MIT World. To immigrate, click the “Immigrate” button from the “Function Area” in the upper right corner on the window. Fill in all the required information and make sure you use your real name because this information is needed for your submission and this name can not be changed once it is set!

Overview of the client interface
The interface of the client browser is displayed as Figure 1. It is divided into six areas: 

1. Area 1 is “Left Window”, where you could find information regarding user guide, existing worlds and contact list. 

2. Area 2 is “3D Window”, where all the visual elements are displayed and most of the interactivity occurs. 

3. Area 3 is “Text Display Window”, where the conversation among avatars is displayed. 

4. Area 4 is “Right Window”, which is used as a web window to view web pages. 

5. Area 5 is “Function Area”, different functions are represented as drop-down menus, textual or graphical buttons. You can roll over them to view their names. 

6. Area 6 is “Text-entry and Whisper Area”, you can type words here to chat with others. “Whisper Area” is invisible by default, you need to activate it by clicking “Whisper” from “Option” drop-down menu in “Function Area”. You can talk to a certain person without disturbing others by using “Whisper”. 
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Figure 1. Client Browser Interface

Navigating and communicating in Active Worlds

The followings are some tips for navigation and communication.

· Choose an avatar for yourself from the “Avatar” drop-down menu in “Function Area”. You can view your selection by clicking the “Third Person” view button in “Function Area”.

· You can control your avatar to move forwards, backwards, turn left and right by using the arrow keys from the number pad in you keyboard. You can speed up by using the “Ctrl” key together with the arrow keys and you can walk through all the barriers by using the “Shift” key together with the arrow keys.

· You can move up and down by using “+” and “-“ keys from your keyboard.

· To chat, you should type in the “Text-entry Area” and press “Return”. You may need to left click in the 3D window again after typing in the text-entry area in order to move your avatar.

Building in Active Worlds

The building method in AW is duplication. To start a new project, the first thing is to duplicate an existing object nearby, rename it to the object you would like to use and move it to the spot where you would like to start the project.
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Figure 2. Object Properties Window
1. Duplicate an object: in AW, each student is given a piece of land. There is a sign on each piece of land to identify who is building on that land. Right click this sign to activate the “Object Properties” window (Figure 2). Roll over each button on the top to view its function. The button on the top of the windows allows you to delete, duplicate, move back, move forward, move left, move right, move up, move down, turn left the selected object. For this exercise, click the “Duplicate” button, which duplicates a sign object behind the original one. With the “Object Properties” window activated, in “Object” line change “sign1.rwx” to “wall001.rwx”. This creates a wall object. Close the “Object Properties” window, you will see the wall object behind the sign object.

2. Moving an object: right clicking the wall object to activate its “Object Properties” window, use relevant buttons to move or turn the object and locate it at a spot as you desire.

3. Modifying object properties: the wall object now is view as it was modeled originally. Add a descriptive command “My Wall” in “Description” line. “My Wall” as text will appear when rolls over this object. Add an action command “create color red” in “Action” line to change it to a red wall. Add another action command “activate url "http://web.mit.edu/"" to link a web page property to this wall. The web page will be displayed in “Right Window” when a person left clicks the wall. The “Owner”, “Name” and “Built” lines give you some information about this particular wall object that the server maintains, and you cannot change directly.

4. Using sign objects: as described earlier, sign objects enable you to write on them. There are five different sign objects “sign1.rwx”, “sign2.rwx”, “sign3.rwx”, “sign4.rwx” and “sign5.rwx”. Type “create sign "Virtual Architecture"” in “Action” line from “Object Properties” window, the text “Virtual Architecture” will be shown on the surface of the sign object. You can add customized colors for the text. “create sign "Virtual Architecture” color=black bcolor=yellow” adds black text “Virtual Architecture” on yellow background to the sign object. 

5. Look for objects in AW Building Library: you can now use any objects from AW Building Library for your project. The list of objects can be found by clicking “User Guide” tag on top of the “Left Window”. The Help file will appear in “Left Window”. Look for “AlphaWorld Building Objects” and click a relevant category, the list of objects will appear in “Right Window”. You can then preview them in “3D Window” by right clicking an object and change “Object” line in “Object Properties” window. Use this method combing with steps 1, 2 and 3 to add all the building elements from AW Building Library for your project.

6. Switching views during the building process: In order to line up objects in the 3D world, you will need to switch your views. The movement of an object is relative to your position in the world with respect to the object you are moving. In order to be precise about where the object is, you will need to move around the object and see it from different views. You can switch between “First Person” view (button marked with an eye sign in “Function Area”) and “Third Person” view (button marked with an camera sign in “Function Area”). “First Person” view allows you to “Look Up” and “Look Down” (also in “Function Area”). “Third Person” view allows you view “3D Window” with your own avatar in it. Another pair of useful functions is to move your eye level up and down by using “+” and “-“ from your keyboard. For these two keys, you can also combine with “Ctrl” or “Shift” key to speed up or to walk through all barriers. You can keep pressing “End” key in your keyboard at any time to move your viewpoint backwards to gain a bird’s eye view of your project. Smaller increments of object movements is possible by holding down the shift key while clicking on the arrow buttons in the object dialogue box.

Assigning Behaviors to Objects in Active Worlds

The Action field of an object allows the objects you build to behave in interesting ways. For example, you can have an object play a sound when approached or bring up a web page when clicked on. Multiple actions can be combined together on a single object to create complex behaviors. 

The general syntax of an action is as follows: 

trigger command [, command, ...] [; trigger command...]

As you can see, all actions are combinations of triggers and commands. The trigger specifies what must occur in order for the commands to be carried out. For example: 

create solid off

This action makes an object "unsolid" so that users can pass through it without colliding with it. "create" is the trigger and "solid off" is the command. Another example: 

activate url www.activeworlds.com

This action displays the Active Worlds home page when the user clicks on the object. "activate" is the trigger and "url www.activeworlds.com" is the command. 

The following triggers are available: 

*
create - occurs when the object first comes in to view 

*
bump - occurs when the user physically collide with the object 

*
activate - occurs when the user clicks on the object with the left mouse button 

*
adone - occurs when an animation running on the object completes 

Each trigger can be combined with one or more of the following commands: 

*
animate - runs an animation on the object 

*
astart - starts a stopped animation 

*
astop - stops a running animation 

*
color - assigns a new color to the object 

*
corona - places a corona over the object (new in 3.3) 

*
examine - allows users to rotate the object with the mouse 

*
frame - changes the current animation frame 

*
light - places a light source on the object 

*
move - causes the object to move smoothly from one position to another 

*
name - attaches a name to the object 

*
noise - plays a sound effect (.wav or .mp3 file) 

*
picture - displays a picture (JPEG) on the object 

*
rotate - causes the object to spin around one or more axes 

*
sign - places visible text on the object 

*
solid - makes the object either solid or unsolid (i.e. un-bumpable) 

*
sound - attaches a sound to the object (a .wav, .mp3, or .mid file) 

*
texture - places a new texture on the object 

*
teleport - sends the user to a new location instantly 

*
url - displays a web page in the web browser 

*
visible - makes the object either visible or invisible 

*
warp - moves the user to a new location gradually 

Multiple actions on a single object

You can attach more than one command to a single trigger by separating the commands with commas. For example: 

create visible off, sound background.wav

This creates an object which is both invisible and also the source of a continuously playing sound file. 

Multiple trigger/action pairs can be combined on a single object by separating them with semi-colons. For example: 

create visible off; bump url activeworlds.com

This creates an object that is invisible, but which will display the Active Worlds home page when bumped by a user (objects can still be bumped while invisible.)

Creating your own object models and media in Active Worlds

1. Creating customized models with CAD applications: you could model your own objects to be use in AW. The first thing is to model in any CAD applications such as ArchiCAD, AutoCAD or 3D Studio which can export “.dxf”, “.wrl” (VRML) or “3ds” files. Before you export your own models, you should keep the file size small for the ease of your building process later in AW. You should also consider how to separate the model into different objects as each action in AW can be only applied to an object but not a part of the object. For example, if you have a model as a whole to be used in AW, you can only apply actions to the whole model. You might want each component to have its own actions, in this way you will have to separate the model and export different parts of this model individually from the CAD application. Then you can combine them together again as a whole in AW.
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Figure 3. “Save Object As” Window from AccuTrans 3D

2. Translating CAD models: the format recognized by AW is RWX. We use a translator called AccuTrans 3D to generate “.rwx” file from the models exported from CAD application. For your own use at home, download the installation file from “http://www.arch.usyd.edu.au/~nigu6276/va2002/accutrans.zip”. Install the file and start the application. Open your model by clicking “Open” from “File” drop-down menu, you then can preview your model from Accutrans. Please refer to Accutrans Help from “Help” drop-down menu for additional information. To export, select “Save as” from ‘File” drop-down menu to activate “Save Object As” window (Figure 3). Select “.rwx” as “Save File Type” at Area 1. One meter in CAD equal to ten AW units, so use “0.1” as “Output Scale Factor” at Area 2. Tick the “UV” at Area 3 and finally save the model by clicking “Save” button at Area 4. To avoid confusion, please use the following style to name your file “va” + “your name” + “file name”, for example “vaningwall.rwx” (all in lower case).

3. Importing .rwx files to AW library: once you have the “.rwx” files, zip each of them into a “.zip” file using “Winzip” with a same name, for example “vaningwall.rwx” to “vaningwall.zip”. Send these “.zip” files to marym@mit.edu, they will be uploaded to the server regularly. 

4. “.rwx” files can be edited with any text editors such as “Windows Notepad”. The following items discuss how to edit “.rwx” files with text editors.
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Figure 2. A “.rwx” File with Definition of Surface, Color, Scale and Rotation
5. Rotating: “Rotate <x> <y> <z> <angle>”. This command rotates the current transformation matrix by the given angle around the given vector. “1 0 0” rotates around the X axis, “0 1 0” rotates around the Y axis and “0 0 1” rotates around the Z axis.

6.  Scaling: “Scale <x> <y> <z>”. This command scales the current transformation matrix by the given amounts along the X, Y, and Z axis. A scale factor of 1.0 results in no change along that axis. 
7. Surfacing: “Surface <ambient> <diffuse> <specular>”. This command sets the current surface lighting properties. All components should be specified in the range 0.0 to 1.0. The ambient component specifies how much the world's ambient light source "shines" on polygons. The ambient light source shines equally on all polygons in all directions. The diffuse component specifies how much the world's directional light source "shines" on polygons. Currently Active Worlds does not support specular lighting, 
8. Coloring: “Color <red> <green> <blue>”. This command sets the color of the current material. The individual color componets should be specified in the range 0.0 to 1.0. 
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Figure 3. A “.rwx” File with Definition of Texture.

9. Using texture: to specify a texture for a “.rwx” file, first of all, you need to make sure that all the vertexes in your “.rwx” file have “UV” values (see Figure 3). You then need to create a texture in “.jpg” format and submit it to the drop-box of AW textures for Virtual Architecture course to be uploaded (from any PCs in the computer lab, select Network Neighborhood/Dropbox/Dropboxes/VA2002/texture),. You can also reuse some existing texture files from “http://www.arch.usyd.edu.au/kcdc/aw/object_library/textures”. You then can specify texture in “.rwx” file using command “Texture <name>”. In Figure 3, a texture called “tiles01” is used. An image file called “tile01.jpg” has been uploaded to the server, the AW render will render this “.rwx” file with the image “tile01.jpg”.

10. Using sound: sounds in AW are specified using action commands in “Object Properties” window from “3D Window” in AW. First of all, you need to make a sound file available on the Internet in “.wav”, “.mid”, or “.mp3” format. Then you can use the command “ create sound <url>” in “Actions” line of an object from AW to load this sound to AW. 
Another way to generate your customized models for the use in AW is to modify existing files in “AlphaWorld Building Objects” library using the techniques being exercised above to rotate, scale, to change a color or texture. In this way, you need to download a model file from “http://www.arch.usyd.edu.au/kcdc/aw/object_library/models”. Unzip this file and open the “.rwx” file to make the modification, rename the modified file using the required style then zip it and submit to the drop-box of AW models for Virtual Architecture course.

